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Introduction

Welcome to The Baptist College of Florida!

Information Technology (IT) has developed this guide to provide new and returning students with information needed to
utilize the College’s Information Systems.

The Baptist College of Florida provides Information Systems to meet operational, financial, and academic needs. These
resources are valuable, and their abuse can have a far-reaching negative impact. IT is responsible for balancing the need
for security with practical application.

The mission statement for the Information Technology (IT) department includes the charge to facilitate computing services
that allow BCF to accomplish its mission of educating and training ministers and other religious workers. As such, it may

not be appropriate to support all the technology services that are available in a home use environment on the Graceville
campus.

Feedback

Questions, comments, and recommendations can be submitted to IT@baptistcollege.edu.

Support

IT provides and supports the data systems and network resources that make up the College’s Information Systems. IT
supports faculty, staff, students, prospects and alumni as they use college resources.

Support for Personally Owned Equipment

IT does not provide support for systems owned by individuals. The Baptist College of Florida’s Computer and Information
Systems Policy (CISP) ' does not allow IT to support student owned computers or computer related equipment.

Computer & Information Systems Policy

The BCF Computer and Information Systems Policy (CISP) governs all of the College’s computers and information
systems. This policy can be found in the student handbook and is accessible online at
http://www.baptistcollege.edu/IT/media/CISP.pdf.

At the direction of the Senior Vice President, IT conducts random audits to ensure compliance with the Computer and
Information Systems Policy.

Copyrights, Trademarks and Intellectual Property

Do not violate the copyright, trade secret, patent or other intellectual property rights of any person or company. Do not
install or distribute software products that are not appropriately licensed. Do not make unauthorized copies of copyrighted
material.
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Authorized Student Computer Account

In accordance with the BCF Computer and Information Systems Policy, each student is issued an authorized computer
account. This account may be used only in accordance with its authorized purpose. The student is responsible for
safeguarding his/her own authorized account, specifically user name and password (PIN). The student is solely
responsible for all activity on his/her account.

The student is authorized to use his/her account for the following purposes:
e Email for academic and personal hon-commercial purposes
¢ Internet use for academic and personal non-commercial purposes
e Computer Lab and Library computer use for academic purposes
¢ Limited printing in the Computer Lab, Music Labs & Library for academic purposes

The student is authorized to connect a notebook, desktop or handheld computer to the wireless network. No other type of
connection is authorized. Students may not connect or allow the connection of any other devices to BCF Information
Systems.

The PIN

Your user ID and personal identification number (PIN) is the entry point to BCF Information Systems. All network activity is
logged by userid where applicable; any activity shown as associated with a particular user id is the responsibility of that
user. Keep your PIN secure to ensure any activity is logged to the correct user. General guidelines for keeping your PIN
secure are:

1. Do not save your PIN in your internet browser or elsewhere if it has an option to do so.

2. Do not ask anyone else for his or her PIN. Do not share your PIN with anyone.

3. No PIN should be spoken, written, e-mailed, hinted at, shared, or in any way made known to another.

4. No PIN should be displayed or concealed on or near your computer workspace.
If you believe someone else may know your PIN notify IT immediately, and a new PIN will be issued.

BCF Student Access Computer Locations

Computers are available for students to use in the Computer Lab and the Library. The Computer Lab and the Library may
have additional rules governing the use of these computers. Music students are also permitted to use the computers in
the Music Labs. Students are prohibited from using all other College owned computers including those in the classrooms
and offices.

Student Network Drives

These are available only on BCF Student Access Computers on Graceville Campus. Save all files to the “U:” drive when
using Computer Lab or Library Computers. (Access the “U:” drive by opening “My Computer.”)

Printing & Making Copies

Student printing is available only on BCF Student Access Computers. The only copier designated for student use is
available in the Ida J. McMillan Library in Carlton Hall.

The printers located in the Computer Lab, Music Lab and the Library are for academic purposes only. These printers may
not be used for personal, ministerial, or commercial purposes. Students are prohibited from using other College owned
printers/copiers.

Students may print one copy of a document. Additional copies should then be made using the publicly accessible
copier/printer located in the Library. Students may not use copier function without paying for the copies.

Arrangements should be made with the professor if a student needs a class set of a document.




Email Guide

Students will be assigned a baptistcollege.edu email address. This email address will be used for college
correspondence.

Outlook Web Access

Check your student email online by visiting: https://mail.baptistcollege.edu

Mobile devices like cell phones and handhelds can access a text only version at https://mail.baptistcollege.edu/oma

Username: ID Number Password: PIN

Example: Username: 99999 Password: XXxXXxx

Unsolicited Commercial Email - SPAM

The College employs several levels of spam prevention including Microsoft Intelligent Message Filter, Microsoft Forefront
antivirus and spam filtering, real-time block lists, reverse DNS lookups, and Astaro spam filtering.

If you receive spam in your mailbox, add the sender to the Blocked Senders List in Outlook Web Access or your email
client; then delete the spam message.

Periodically, check your junk email folder for messages that may have been marked incorrectly.

Anti-Spam Resources:
Toward a Spam-Free Future: http://www.microsoft.com/mscorp/execmail/2003/06-24antispam.mspx
How to Keep Spam out of Your Inbox: http://www.microsoft.com/athome/security/email/fightspam.mspx

Setting up Outlook or Other POP3 Mail Reader
POP3 is available to students for email account access. The settings required are:

. The email account type is POP3.

. Your email address is usually in the format of preferredname.lasthame@baptistcollege.edu

. “mail.baptistcollege.edu” is both the Incoming mail server and Outgoing mail server.

. Your “User Name” or login for the Incoming mail server is in the format of “StudentiID@bcf.edu”.
. Your “User Name” or login for the Outgoing mail server is in the format of “StudentID”.

6. Your PIN is the password for both the Incoming and Outgoing mail server.

The following are example screens from Microsoft Outlook 2007:

Add New E-mail Account B e emisenion &

Garers | Outgomg Server  Cornedtion | Advanced

ga b~ WON PP

Internet E-mail Settings

Each of these settings are required to get vour e-mail accounk working, 7] My qubgoing server (SMTP) requeres suthenbcation
O Lse save sattings aa iy sormr) mad server
Lo onusng
User Information Test Account Settings Lhver bjarna: 2123424
Your Marme: Preferrediame Lastiame After filing out the information on this screen, we -
recommend you test your account by clicking the [V Rarvarbac pazomord
E-mail Address: lastname@baptistcollege. edu buttan belovw, (Requires netwark connection) [ IRagare Sacue Passeond futhertcaton (SPA)
server Information L] 00 0o coedg el server bafore sendog mad
Test Account Settings ...
Account Type: POP3 I
Incoming mail server: mail baptistcollege. edu

Cutgaing mail server (SMTPY | mail, baptisteollege. edu

Logon Information

User Mame: 123456@bcf . edu
Password: Jr——

Remember password \—‘J |L
[]Require lagon using Secure Password Authentication (SPA) More Settings ...

< Back ” Mext > ][ Cancel ]
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MyBCF

MyBCF is our online campus. MyBCF is the website that allows you to register for classes, check your grades, view
campus groups, edit personal College information, and access online portions of courses. The website is
https://mybcf.baptistcollege.edu.

Browsers

The browsers that have been tested and approved for compatibility with this website application are:
e Internet Explorer 7.0 @ for Windows XP
e Firefox 2.0 and 3.0§® for Windows XP, Mac OS X(10.2 and later)
Versions later or earlier than these may or may not work properly.
Note: Java and JavaScript must be allowed, or enabled, in the browser’s configuration. Popups must be allowed from this
website as well.
*** The above does NOT apply to using the BCF Wireless Net, only to the website https://mybcf.baptistcollege.edu***

Your “User Name” for MyBCF is your Student ID number; the password is your PIN.

Using MyBCF

Check out the "Getting Started" and "Student Navigation" topics on the left sidebar of the home page for tips about using
MyBCF after you log in.

The following is an example snapshot of the login page for MyBCF:

7 MCE Horree | Masve - Micresel Sales it Explores provided by The Begtiint Collepe of Flarida

(7; o | & tege (et hagnocdege s8ika

b Astao Wenkdom 6l oPuen (B Posefrnt Avtivis Dnfeitions Repcet « 7 dups o ke Customum Lrks

&8O oww | e T 0 w0k 0-£0 3

B s e of i

Camgsn Aanountemunty

sgioore to ECE
s g Welcome te The Baptist Collepe of Flanda's orine nformation ports You hawe no INComng 3nnouncements
Larand bescaiies MVGCF
: N Samn A5l Sssasamtannls
Rermous Anepyrourrarts ) _ !
Eamrn { = If this & your ot bmo vistng MySCF, plosoe vt the "Getting
— STatad" Lopic i the S0ebar of D¥s window 100 TP 0 Dasc Nawgation Evonts Calendar ]
uf the site
g M, you wil tnd that the "Student Tumsay, 11 August
g Pont for the iInforma w2 Sequtrenge Cgtgrrens DuoeTy
- .
If you are 3 member of the faculty Aftor you g 0, you wil fnd that
0 Faculty Infomaton” b will De 3 9U0d startng pont for the
nformaton you need nost often. Aftw you log i, phesss visk the hursday, 11 A.q..ft
Facuity Navgaticn' tope in the sdebar of ths wirddow for more Qssre dciroves b BAZMITa s ST
BCE yrupl Boosatoes detatiod Mavgaton tpe
_ 2 4 Feiday, 14 Augant
Manday, 17 August
Campus Resources Smsandclesoa T
SE.O0AM - 1100AN Crasel-Jr, Thormas &, Sirean
Tassday, 18 August
a0 - 11-904M Chaggl Do, Thyrege & Meghee
e - 2 00PH BN
Laa Ml
Laf s Cazria
2w in Mapt Sonar

| S Lacad ittt Som -
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BCF Wireless Net

The BCF wireless net is the college operated wireless service available throughout most of the Graceville Campus. The
wireless net is currently available to faculty, staff and students, and offers fast data connection speeds.

To use the service, an 802.11b/g or WiFi device is required. Most notebooks, desktops and handheld PCs come with
wireless or can have an 802.11b/g wireless adapter added. Contact your hardware manufacturer for more details about
your specific device.

The SSID name is bef wireless net. Access to the internet from the BCF wireless net requires the use of the BCF proxy
server. The address for the proxy server is 10.1.28.1, and uses port 8080.

Send questions or comments regarding the service to IT@baptistcollege.edu.

Security of wireless networking

Wireless networking is insecure. Any user on a wireless network can spy on unencrypted traffic from other wireless users.
For this reason it is important to use Secure Socket Layer (SSL) when connecting to sites or service that contain private
or confidential information, by using the https prefix and not the http prefix for websites that contain personal data.

Who do I call for support?
Notify IT of wireless network problems by calling 850.263.9081, 850.263.9058 or 850.263.9020.
BCF and IT will not support computer equipment or software that is not owned by the college. In other words, IT does not

provide technical support for student owned equipment. It will be the sole responsibility of the student to install and
configure his or her personally owned devices and software

If you encounter problems, first make sure you have installed your wireless adapter according to the installation
instructions that came with the wireless adapter, and then contact the manufacturer for support.

Can | register for a static IP/hostname?

No, BCF Information Systems only support dynamically assigned IP addresses.

Wireless network reception

If you have problems with reception, try moving the computer or wireless adapter. An external antenna has been shown
to improve reception in some areas of the Graceville Campus.

2.4 GHz Devices and College Policy on Personal Wireless Networking on Campus

The BCF wireless net on the Graceville campus relies on the 2.4 GHz frequency band. Many devices can interfere.
These devices include 2.4 GHz cordless phones, wireless internet routers, Base Stations, or access points, computers
with wireless peer-to-peer mode enabled or operating as a software base station, 2.4 GHz video monitors or radios, and
any other devices that operate on 2.4 GHz. The devices should not be operated on the Graceville campus due to the
interference they cause.
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BCF wireless net: Installing and configuring your hardware

Install and configure your hardware according to the manufacturer’s specifications and instructions.

D ST — w

Windows XP and Vista e P ————

| (P A ek g w5
IT recommends that Windows XP and Vista users allow Windows to manage R snyeany iy W =
their wireless connections and not special utilities as provided by some : i —

wireless card manufacturers.

Windows XP instructions are provided for your convenience only. These

instructions apply to computers with Windows XP SP2 or higher using

Windows to manage wireless access.

1. Right click on the Wireless Connection Icon in the system tray at the
bottom right hand corner of the screen, and select "View Available Wireless 7
Networks" TR Pk Cooradiion s oy cosnected
2. You should see a list of available wireless networks. If you do not see bcf soyl e Ersbrt
wireless net then you need to get into range of a BCF wireless access point. .. .. @ EADT Y
T 224
3. If you select "Allow me to connect..." you will then be connected to the BCF piudte
Wireless Net. [ W Wk Ciswarias Waseries LI |
4. It may take a moment, but an icon in the lower right hand corner of your desktop should
eventually state that you are connected. Tz
5. You are now ready to authenticate to the BCF Wireless Net. —
If you have a problem access BCF wireless net add the following configurations pp——
6. Right click on the Wireless Connection Icon in the system tray at the bottom right hand o
corner of the screen, and select "Status” el
7. Select Properties.
8. Change to the Wireless Networks Tab. Select “Advanced.” Select Access point e s
(infrastructure) networks only. Check the automatically connect to non-preferred '
networks box. R A
9. Select Close, and Select OK TTmmmmm—
Mac OSX

Basic Mac OS X instructions are provided for your convenience only, as IT does not have the ability to test each version

of Mac OS X. These instructions may not be exact for each of the versions.

1. Apple menu > select Location > select Networking.

2. Set "Show" to AirPort.

3. Make sure that under the TCP/IP tab "Configure" is set to use DHCP
4. Make sure that under the Proxies tab

e Enter 10.1.28.1 in each field (make sure the box beside the field is checked)
e 8080 should be included in each Port
e |Leave the bypass proxy box blank and do not check the FTP Proxy.

5. Make sure that under the AirPort tab "show AirPort status in menu bar" is checked.
6. Click "Apply Now" to save these settings. Your Mac should now be configured to use the wireless network.




Configuring a Browser

Instructions to configure your internet browser to use the proxy server:
e Using Internet Explorer::
o Tools Menu > Internet Options > Connections Settings> LAN Settings button

Uncheck "Automatically detect settings" if it is checked.
Check the use a proxy server box.
In the Address box type 10.1.28.1
In the Port box type: 8080

o Click OK
e  Using Firefox:

o Tools Menu > Options > Connections Settings
Check the manual proxy configuration box
In the HTTP proxy box type 10.1.28.1
Use Port: 8080
Check the box for use this proxy server for all protocols.
o Click OK

You may use a PAC file as an alternate method of configuration. A basic PAC file can be downloaded from
http://help.wireless.baptistcollege.edu/bcfwireless.pac.

O O O O

O O O O

Configuring Other Software
First, verify that your Internet browser is successfully using the proxy server.
¢ Using Windows Media Player, QuickTime Player or RealPlayer:
o Use Proxy Settings of the Web Browser
e Using Skype:

o Install Skype and setup user account from an unsecured network or come to the IT Department for assistance while

installing Skype.
o Setup Skype to use a SOCKS5 proxy (10.1.28.1 on port 1080) with authentication

o Type “bcf\” and your BCF student ID in the Username field (as pictured below,) and your PIN in the password

field
e x|
R Genera ~ Commection
R privacy Use port Sor incoming cornettions
Tacy
-
¥ Use port 20 and 440 as stematves fir nooowng corectons
P Notficatons
™ Alow Scype to modfy frewal setangs
A s
Sounds
(&) Sound Devices fsocxss =
] Hotkeys Frast fio.12s Port 3020
s ey
¥ trabie proxy suthenboston
Usemane pcfl 123456 Password FT-T-'--.-
3 Call Forwarding
B Vokemad
o Video
) updates Bcteted Tadhs
Q SNS Messages o Lean more ! Sype deak vt oynees ond freasls
'." 2 {
W fonon Sinve Corvel

Instant Messaging Clients

We understand that many Graceville campus BCF students use instant messaging. We cannot guarantee that any client based instant
messaging product will work through our firewall. However, the firewall will allow the use of web-based instant messaging clients that

use AIM, MSN, and Yahoo services. In research, we found several web sites that can be used for this: www.meebo.com,
www.koolim.com, and www.iloveim.com.
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BCF wireless net: Internet access login
When logging onto the Internet, you must enter your student ID and PIN.

\  Enter username and password for proxy at 10.1.28.1

.

| s

User Name:
123456 |

Password:
E e J

[, OK ] [ Cancel ]

Each time you start your browser you should have to login. This does not mean every webpage you visit will ask you to
login. If you browse the Internet, close your browser, and then re-open your browser, you will have to login again. The
same is true if you open multiple browser windows.

Internet content filter

Most web sites are categorized, and websites that meet certain criteria will be blocked and logged. For example, all
websites categorized as pornography will be blocked. If you visit a website that matches these criteria, you will see a
screen such as this.

& Content blocked

Vhile trying to retrieve the URL:

The content is blocked due to the following condition:  The URL you have requested is blocked by Surf Protection. If you think this is wrong, please contact the BCF IT Department.

Report: category not allowed
Your cache administrator is: it@baptistcollege.edu
.‘ astaRD Powered by Astaro

If you feel that a website is incorrectly categorized, please e-mail the website’s URL to the IT Department
(it@baptistcollege.edu) so we can investigate the issue.
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Internet file downloads

For your protection and the protection of the college’s network, all web-based content will be scanned for viruses and
spyware. When you download a file, you will see a screen like this.

The item you have requested is being downloaded

Plexse wat ...
URL ip: | I e-sword, nety. feeno 7% exe
Stage 1 of 3 dosnkcading
Domnloadng 2716kh of 1778%h at a spe=d of 3024b/s
Estimated time jeft St seconds

After the firewall downloads the content, the firewall will then scan the content for viruses. If the file is clean, a screen will
be presented that will prompt you to download the file to your computer. However, if the file is infected you will be

presented with a screen that gives you information on the virus it detected, and you will not be able to download the file to
your computer.

The mission statement for the Information Technology (IT) department includes the charge to facilitate computing services
that allow BCF to accomplish its mission of educating and training ministers and other religious workers. As such, it may

not be appropriate to support all the technology services that are available in a home use environment on the Graceville
campus.
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Computer Security

Virus Protection and Firewall

It is recommended that students run a personal firewall on any computer connecting to the BCF wireless net. Microsoft
Windows and Mac OS X both have built-in firewalls. Computers must_be running virus protection with a virus pattern that
is no more than 30 days old. It is a best practice to update the virus pattern or virus definitions every day.

Listed below for your convenience are several anti-virus resources. IT makes no guarantee as to the quality or
effectiveness of these products.

AVG Anti-Virus

http://free.grisoft.com/freeweb.php/doc/2/ (Free Edition is the well-known anti-virus protection tool.)
Avast! Anti-Virus

http://avast.com/eng/down_home.html (Free of charge for home users for non-commercial use.)
ESET

http://www.eset.com/

Trend Micro

http://www.trendmicro.com/en/home/us/personal.htm

Panda Software

http://www.pandasoftware.com/

Computer Associates

http://www.my-etrust.com

McAfee

http://us.mcafee.com

System Updates
Microsoft Windows

Windows Update Information: http://www.microsoft.com/security/bulletins/automaticupdates.mspx
To get Windows updates immediately: http://windowsupdate.microsoft.com

Microsoft Security Help and Support for the home user is dedicated to help you obtain support for security-related issues such
as viruses and security updates. http://support.microsoft.com/?pr=SecurityHome

Enhance the security for a Windows PC: http://www.microsoft.com/athome/security/protect/windowsxpsp2/Default.mspx

Mac OS X

Get the Latest Security Updates for Mac OS X: http://www.apple.com/support/

To get updates immediately:

From the Apple menu, choose System Preferences.

From the View menu, choose Software Update.

Click the Check Now button (or Update Now in earlier Mac OS X versions).

In the Software Update window, select the items you want to install, then click Install.

Enter an administrator account name and password.

After the update is complete, restart the computer if required.

Repeat these steps to see if more updates are now available. Because some software updates are prerequisites
for others, you may need to repeat these steps several times to complete the software update sequence.

NogakrwbE

11


http://free.grisoft.com/freeweb.php/doc/2/
http://avast.com/eng/down_home.html
http://www.eset.com/
http://www.trendmicro.com/en/home/us/personal.htm
http://www.pandasoftware.com/
http://www.my-etrust.com/
http://us.mcafee.com/
http://www.microsoft.com/security/bulletins/automaticupdates.mspx
http://windowsupdate.microsoft.com/
http://support.microsoft.com/?pr=SecurityHome
http://www.microsoft.com/athome/security/protect/windowsxpsp2/Default.mspx
http://www.apple.com/support/

